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ThinkerShield
board

A quick-start board made

up of a unique blend of
on-board components
to make it easy to start

doing computer controlled

activities. It can also be
expanded using standard
Arduino compatible
components.

Personal
computer
running Arduino

software

Arduino software is free to
download and use from:

www.arduino.cc

Arduino board

Such as:

e Arduino Uno

e Freetronics Eleven
e  Genuino Uno

e orany Arduino
compatible board that
has a standard Arduino
UNO header layout.

USB cable

To connect your Arduino
board to your computer.
This provides power to the
board and allows program
upload.

¥Fwell, almost! You will need a few other components for the Let’s.Get.Beyond. It projects:
2 LEDs (red, green, t\el\ow) , 3 resistors (220 olm) and 9 wires with adlisod’or c\if:.
GePem from any electronics shop Fcr:)uf a few dollars.



Introduction

The ThinkerShield for Arduino is a learn-by-making product by
Thinkspace at the Museum of Applied Arts and Sciences in
Sydney, Australia.

At Thinkspace we love learning-by-making. We think everybody should be
able to dive in and just start playing and learning right away.

The Arduino board and programming language is a worldwide
phenomenon bringing the exciting world of electronics and computer
control to anyone with a computer and a USB cable.

So, together with the clever folks at Freetronics, we created the
ThinkerShield for Arduino. The ThinkerShield makes it easy for you, your
family, your schoolmates and friends to start programming and controlling
things with your computer in minutes! No need for any wiring or soldering
or program knowledge.

Even if you have never seen a computer program before, we guarantee
you will be making things flash, buzz, beep and respond in no time.

Then, when you are ready to move on to bigger things, the ThinkerShield
has 8 built-in external connectors that make it easy for you to connect all
manner of devices like switches, lights, motors and sensors.

So, don’t just watch what’s going on in the world of electronics and
computing. Take a step to start understanding it. Grab your ThinkerShield
and get.on.with.it!



Get.Connected

1. Install Arduino

Installing the Arduino software for
your computer is usually pretty
straightforward.

Just go to the Arduino website and
follow the links to the downloads
page. Select the latest version for
your computer (Windows, Mac

or Linux).

www.arduino.cc

The site covers everything you
need to get up and running and to
troubleshoot any problems you
may have.

2. Install drivers

Depending on your computer and
operating system, you may need

to install a driver for your Arduino
board. Again, the best advice we can
give you is to follow the steps set
out on the Arduino site. Just search
‘install drivers’ or go straight to:

www.arduino.cc/en/
Guide/Howto

Of course, if you are using an
Arduino compatible board
you should install the drivers
recommended by the board’s
manufacturer.

3. Connect your
ThinkerShield to your
Arduino and computer

Carefully align all your
ThinkerShield’s leg pins with the
sockets on your Arduino and
press them together.

Make sure Q\/erb\ﬂr\;ns \s
alisnzd, otherwise You may
bend the pins or the sockets.


http://www.arduino.cc/en/Guide/Howto
http://www.arduino.cc/en/Guide/Howto

Connect your Arduino
to your computer using

the appropriate USB

connector such as a USB
B-Type cable or micro
USB cable (as per your
board manufacturer’s

specifications).

1€ your

Thinkershield is

3effin9 power
Erom the
Arduino, this

~
blue LED will

.n‘owl on.

Once your board is connected, both the
serial port and board selections can be
made from the Arduino ‘Tools’ mena. \

4. Select the board \
and serial port /
//
The Arduino software //’
needs to know which yig

communication port is

being used and what type

of Arduino board you have.

The board type will be

stated in the manufacturer’s specifications (such as
Arduino UNO).

The serial port on Windows will likely
be COM3, COM4 or COM5. On a
Mac it will be something like:
/dev/cu.usbserial-1B1.

If you can’t easily see which port is

being used, try:

e using system profiler (on Mac) or
device manager from the control
panel (on Windows) to identify
which port the board is using

e look at the list of available serial ports (in the
Tools menu), then unplug your board and re-open
the menu. The entry from the list that disappears
is the correct serial port for your board

e checking troubleshooting on the Arduino site.



5. Download

ThinkerShield
program code files

All activities in this book have
associated program code for you to
load and complete.

Before you start your Arduino
software, download all the program
code files from our site:

ma.as/
thinkershieldresources

Copy the files to a convenient
location on your computer. The
code files are divided into two
folders: activity and completed. The
files in the activity folder are for
working through the activities. The
completed versions are ready to be
uploaded and run at any time.

6. Launch!

Launch the Arduino application
(arduino.exe) you have previously
downloaded.

When it opens:

1/

2/

3/

4/

5/

go to File/Open...

navigate your way to your
ThinkerShield folder you just
downloaded

open the folder called

ts_In_A_Blink

double-click on the file

ts_In_A_Blink.ino

Get on with it!
[Turn to the first activity]

What is Arduino?

Arduino is an open-source electronics
prototyping platform based on
flexible, easy-to-use hardware and
software. It’s intended for artists,
designers, hobbyists and anyone
interested in creating interactive
objects or environments.

Arduino can sense the environment
by receiving input from a variety

of sensors and can affect its
surroundings by controlling lights,
motors and other actuators.

The microcontroller on the board

is programmed using the Arduino
programming language (based on
Wiring) and the Arduino development
environment (based on Processing).
Arduino projects can be stand-alone
or they can communicate with
software running on a computer

(eg Flash, Processing, MaxMSP).

www.arduino.cc

source: Arduino site



http://ma.as/thinkershieldresources
http://ma.as/thinkershieldresources

What’s.On.Board?

push button

a .ﬁw\f:le

Momenfarv\

Vee (+5 volts) ___ switch
N

GND (O volts) |

|

|

! I

\\\\ ) V |

usb port T :

Con Arduino board) :

to comnect to your \\\ 1
computer Sem——l ) \ "4

b green liski-—emiﬁ-ins
diodes (LEDs)
For w\ogking Us\n'l’

external power socket / I' l‘
Con Arduino board) \

.
to power board when not reset button

connected to a computer press to reset and
reran the cxrranvl

loaded program

external digital pin connections
(DG, DS, DY, D2)

_-=" for connecting additional

7~ components (+5 volts)
I
]
l' detachable buzzer jumper
\' pull it off to silence the
+7 buzzer
e
| % _—- pieeo buzzer
7 .
/ for making sound

and music

potentiometer
a controllable
- variable resistor

[}
lig\nf dependent resistor
for sensing light

~==< external analog pin connections

CAO, M, A2, A3)

for connecﬁns additional
sensors (+5 volts)



Component: LEDs

In.A.Blink

Start by flashing a LED

GND VCC Dé D5 D4 D2

i H Button B
ThinkerShieldByjton  Buzzer

tron.cc/thinker

Acollabor

LED on pin D13

10

We think the best way to make sure your ThinkerShield is
connected correctly and everything is working properly is to make

it do something — straight away! So let’s make one of those cute
little LEDs blink!

,_) Check that
I, everything
Connect your ; / works and start
ThinkerShield to you ! experimenting
; d then to your - . .
Arduino and USB Upload the in a blink!
computer with the program to your
cable. ThinkerShield. T
h ° prords ¢ mpil
A ould Appea Mf:) N9 sketely
l' he Stata, ar Mehfqr,‘h’ in
/ t\f’loqd b As the Ireen
- l/ ar “f’d"\*u
- work_(., o R . IFCVCr .
¢ You NIH‘,.Qe i ‘]Hmng
"N aploadi, .y ¢ Message
will g "9’ and 4y, 9
. ash twice 1 e DIz (g
Open a very simple as ﬁ”f-flr\ecl 0 let 19U ko
Arduino program that will “‘P‘qu.‘h Wit

make the LED on pin D13
flash on and off.

Ingredients




LET’S.GET.(ON).WITH.IT

1/ Set up and connect your ThinkerShield and Arduino
software as shown in the previous pages.

2/ Open the file ts LED In A Blink.ino

3/ Upload your program by clicking on the ‘ icon.

4/ The LED on pin D13
should begin to flash
slowly on and off once
every second. If it does,
everything is working .
ﬁne (y|ppee| — move [ ;';:’HS I_S the l."_,'C'.f\'1F'LETE Program fo
on to step 5). If not Written by Thinkspace L mass. museum/thinksp
check everything in the This code is
‘Not working? column ™
until you solve the i four ThinkerShisld has an
problem. M 1o Pin 13 fas have

r the ThinkerShield In &

E=I=l=}

based on the public

LED connected
0 G & rru:r.st Arduing boards).
f e the pin a name: *led”

5/ int led = 13;

Look at the program i _ThE setup routine runs
code on your screen o upl) b
and find this Se_cllgn\ . F‘“’IT'-'T-:-dea:d; ;;L;:;_'Et;;;mn a5 an output,
Try changing the AN f The loop routing i -
delay (1000) to \ aid loop() { 2 Funs over and
another number such digitalWritefled, HIGHY, f Turn the LED on (Hic
BE delay (500) and o Iv(‘lc.,D.D);, H Wait fr;n--a se-;rc:-ll:; e
click upload to make . _'.»--...-(1131'213?'% LOW; it Turn the LED
the LED flash at a » ! i Wait for 3 zecand

different rate!

once when yoy press raset:

OWer again forever:

y Blink Activity

-domsin code crested by p

H is the voltage level)

off by making the valtage Loy

Not working?

M Is the Arduino getting power? If it
is connected correctly you should
see a tiny green LED next to the
word ON. If not, check your USB
connection.

Is your ThinkerShield connected
correctly to your Arduino board?
Make sure all legs are nicely aligned
and embedded in the black sockets.

Have you selected the correct board
type from the ‘Tools > Board’ menu
on your Arduino software?

Have you selected a serial port from
the ‘Tools > Serial Port’ menu on
your Arduino software?

Is the program uploading
successfully? Do you see the
message ‘Done uploading’?

Still not working?

M Shutdown the Arduino program on
your computer and unplug the USB
from your computer and go through
steps 1to 3 again.

M Go to: www.arduino.cc click on
Forum and look for troubleshooting.



http://www.arduino.cc

Comments: appear in grey. TL\CW are cxr\omod'crw
notes used to tell yourself (and other programmers)
- what the next bit of code is supposed to do or where
it is from. Single line comments begin with //.
Blocks of comments are enclosed between /¥ ¥/

~

\s——‘-

ram for the ThinkerShield In & BElink Activity 7 . . R
————————— keyWords: These words have particalar meaning in the

#* This is the COMPLETE p

Written by Thinkspace ww ‘maas.museurnithinkspace

. duino language. They always appear in orange
) o eted by v arduino.oo Ar ORASS ee )
This code is based on the public-domain sode crasted b - UIi—:—’,ﬂ ‘1 l‘ 3
) ,’__——-—
1 Your ThinkerShield has an LED connected ,/ /—.) void :Qh'\? (' ) {."'3 This runs
M to Pin 13 das hawe most Arduino boar / ( once aFfer ""\f\e frosra\rm \$ u(:loa\o\cd Constants:
I e jj;_pin = name: "led ,’ \‘ and run — vou will always use this Are predefined
‘a__-_-__---_-—r-_-—r _— \ to setup pinModes. expressions in the
N The setup routine runs ance whan -_.‘.-r,.u—p_::_—:;_________/ . 5 o \
void setup() { sm—————————= > void loop € ) i_g This section of Ardaine language
et C w1 nin @z an output. ram . -
I lr\|t|:al|z|>=dt|-|r?Ud]]\';:‘\lt-.l:}llhpm as an outpu ( Fe frOSTQW\ RS COV\‘hV\MOM‘b\ QF”'Q!’ (‘\kl \’HGH, LON,
sinfodedled, © Iy <
\ P \\ the setup( ) function has ran. INPUT, OUTPUT,
M The loop routine runs over and over again forewver: ) fme, Foxl-fi)- T‘/\Ql‘

A -—____"‘.l'-'l:r-r-n the LED on (HIGH is the woltage lewel)
e e 2D i king the voltage LOW Semicolon: ¢ach line of code or orange.
off by making the woltage LUAW

Writelled, HIGH);
10007%;

Witelled, LOW); N Turn the LED ____—) ends with a
N Wait for a second ________—— 5
1N _________——— {_i Curly braces: Your code
SeemmmEeTT must be enclosed between
carlw braces. Debmsger o\r:za:
==Y Ay errors will be
-~ o\i;f\aﬁzo\ here.
'\ ,__) Status b~o«r: D%:flow‘: :‘"‘AC (‘:«Arrcnf board type
N 7 and which COM port is bems wsed.

-
S ccccccccea=——"

12

will appear in blue



What’s in an Arduino program?

There are zillions of Arduino based programs all over the
web that you can download, try out and try to understand.
And you can be pretty sure that they will all have the basic
elements and structure shown here on these pages.

e ———————— Sketch: Arduino people like to
,’ call their programs ‘Sketches’.
|
|

A\ 4
/") (--‘\\ ,’)
N /
\ /
\ /

|
U‘aloo\o\ frlosrogvv\: Click this icon
to transfer your program to the
Thinkershield. This little arrow will
quickly become your fFavourite button!

-—— e

—m———— --
-—— - - —

— ——

-

Vcri(:t\ program:

Check your program for errors before
wploading. You froba\blv\ won’t need
to verify before uploading programs
in this book, bat it might help as you
create larger programs.

Serial monitor:
Open the serial monitor
for wod'ckivxs serial

communication.

Need help, or just want
to start exploring on
your own?

Whatever your question, chances are
the answer is waiting for you on the
official Arduino website. It’s easy to
follow and filled with solutions, forums
and ideas for everything Arduino!

www.arduino.cc

13



Component: LEDs

Getting.Flashy

Controlling a LED

e oo
GND

e 06606 00 00
vCC D6 D5 D4 D2

ThinkerShield Button Buzzer
tron e/ths ered D7 D3

D8 m= | | o

D9 ==
D10 =
D11 ==
D12 w=
D13 ==

GND VCC
e o0

LDR
A4
Reset

ad g
D POTAS =

Light-emitting
diode (LED) on
digital pin D12

Now let’s start talking to your ThinkerShield and take control
of those LEDs so you can make any of them flash how you

want them to!

We first create @
n
variable that we ca
use to hold the'number
of the digital pin of the‘
LED we want to control.

we'll start with pin 12.

Then we use a function
called pinMode() to set
the pin as an OUTPUT.
Otherwise it will default
to an input.

Ingredients

|
/ |
|

Next we do what’s
called a digitalWrite to
the ledPin and send it
HIGH to turn it on.

2
|

Wait one
\\ second.
]
/

v

Do another

digitalWrite to the
ledPin and send it
LOW to turn it off.

/
|
|
|
|

P

_____________ -
( N

The waiting time is
entered as milliseconds
(thousandths of a
second). So delay(1000)
tells the program to

wait one second.

Wait one
second.

v

'
\

Loop around
forever.

\

-
e e e e e e e e > —— —— -

\\



LET’S.GET.(ON).WITH.IT

1/ Open the file
2/

ts_LED Getting Flashy.ino

Look for the comment // Setup LED variables
N Setup LED wariables.

N The setup routine runs once when you press reset:
woid setupi)

and insert the following line of code:

Find the comment // Set the LED pin as an output
! Setup the LED pin as an output.

Look for the comment // Turn the LED on and off

N Turn the LED on and off.

digitalWrite (ledPin, HIGH); // LED on
delay (1000); //Wait 1 sec
digitalWrite (ledPin, LOW); // LED off
delay (1000); //Wait 1 sec

5/ Upload your program. The LED on pin 12 should
flash on and off each second.

This creates a
variable called
‘ledPiv’ that we can
use to refer to the
LiD on F;V\ l1

This gets the LED
on pin 12 reo\o\n\ for
Haubxing.

Tarn the LED on
b~1 setting the voltage
BIGH. Wait, then set the

voltage LowW (and the LED
goes off).

| kinow Flais
Much the o
Mﬁvih’, b
L\Ow to wWri

'.""H&“_rg

is f’refh.'

me as H’\C ﬁr_:f
at now 4ou know
te the code +o




Component: LEDs

. Your ThinkerShield has six LEDs (on digital pins D8-D13). With some
Even.Flashier simple changes to your program code you can easily control them
— one at a time, all at once or in patterns and sequences.

Controlling multiple LEDs Let’s start with two of them!

at the same time

void loop ()

Next, in void loop(),

do various patterns of
digitalWrites to send each
LED high or low according
the on/off pattern you
want to create.

Set up variables for each

fe] ins for
£ the digital pins :
céach of the LEDs you will

be flashing. We chose

e 06606 00 00
Dé D5 D4 D2

ThinkerShieldButton  Buzzer
tl_’(?l"L(S/ths ered D7 D3

oF

‘

~

pins 8 and 13.

-—— e - ——— -
-

- - — — - -—-—

S void setup ()
) Then, in void

setup(), use
pinMode to set

Light-emitting each LED pin as an

diodes (LEDs) on OUTPUT.

digital pins D8

and D13

o Get flashier and
S——— flashier and
) flashier!

,’

Ingredients

16



LET’S.GET.(ON).WITH.IT

1/ Open the file ts LED Even Flashier.ino

2/ Look for the comment // Setup LED variables

! Setup LED wariables
int led1Pin = 13;

Find the comment // Set LED pins as digital outputs
N Set LED pins as digital outputs
pinfodeiled 1Pin, QUTPUT);

Look for the comment // Turn the LEDs on and off
N Turn the LED: on and off

digitalWrite (ledlPin, HIGH); // LED1 on
digitalWrite (led2Pin, LOW); // LED2 off
delay (500) ;

digitalWrite (led1Pin, LOW); // LED1 off
digitalWrite (led2Pin, HIGH); // LED2 on

5/ Upload your program. The LEDs on pins D13 and D8
should flash on and off every half second.

This will define our
second LED pin.

Our second LED is
now readv\ for use as
an ouf(:vd'.

Tarn LEDI on

and LEDZ off

(it wor’t matter if
s o\lrcao\v‘ off).

Do the opposite.

\‘) Page 48

Make a LED
magic sign
/
Next Page

Learn to use the
potentiometer

| added a
third LSD to My
program. Then |
re-arranged the
code so that
all the LEDs
were blinkins
fose,i‘\ne,r and
with different
patterns and
different

o\e.loq:‘.




Component: potentiometer

. Learn to read the ThinkerShield’s potentiometer (a variable resistor)
Pot.Basics and how to print the values to the serial monitor so you can see
Reading the potentiometer them on your computer screen.

N
7/ \4 ( )
Then find out
Send the value to
iable -~ the serial monitor. how the values
Create avaria / : change as
e s i you turn the
M- potPin value. | potentiometer
; e
IR GREITEERE B ! Jy P ——— | backandforth.
[] I | o | analog device so we
D8 == ‘\ use the analogRead()
D9 = TRK N function to get a
?)11(: T " Reset | Bt *‘ value from it.
D12 = D POTAS | o A
D13 == Turn on the "
0000 00 00 00 00 serial port with I pnaled
Serial.begin so J oFent®
we can see the === Coks) AF
values from the os o
—\/\/\/\/\— potentiometer on
1‘ analog pin A5.
Potentiometer
on analog
pin A5 Ingredients

18




LET’S.GET.(ON).WITH.IT

1/ Open the file ts_Pot_Basics.ino

2/ Find the comment // Define potentiometer pin
M Define potentiometer pin

Create a variable

for analos pot pin AS.

3/ Find the comment // Turn the serial port on . . .
. = Activate the serial monitor so

You can use it to see values on
your comtnd”cr screen.

M Turn the serial port an.

. This will put the value of

4/ Locate the comment // Read the input pin the potentiometer into a

# Read the input pin variable called ‘potValue’.

I+ will return values
between O and 1023.

5/ Lastly, find the comment // Print the contents of ...

This line prints the
' Print the contents of the variable to the serial monitar.

value to the serial
i monitor so You can see
! Shar it. Once the program
s n«nn‘ns, click this
iconl!

-t delay before reading again.

and insert this line of code:

6/ Upload your program and open the serial monitor.
Turn the pot back and forth and see how the values change!

See also:

o

d

/
\
\

The serial
monitor lets
you see the
values coming

FTOW\ ownr
1

comgonenfs.

Not working?

M Check your code for missing
;or()or.or{}

M Make sure potPin = 5 (not
some other number).

M Do the baud rates in the

code and on the serial
monitor match?

cereal monster



Component: potentiometer

. . Now that we know how to read the values from the potentiometer
A.Light.Dimmer we can use it to control the brightness of the ThinkerShield’s LEDs

— just like a light dimmer.

Make a light dimmer control

Do an analogWrite( ) to

the LED pin. This gives ~~==~
us more control than

just a digitalWrite( )

which can only switch

between high and low.

o0 o0 oo 00 00 00
GND VCC D6 D5 D4 D2

H 1 Button Buzzer
Mg etiel s S

\
\
\
|
|
|
|
|
|
|
|
\ %

A1l A2 A3

“e ©0 ©0 @0 Experiment with different

S . . otentiometer positions to
~> Then we insert a line of P P

45 that i 0) see the effect on the LED
code that uses the map brightness and create some
function to convert values

ti d lighting!
coming from the (analog) romantic mood ighting
potentiometer so we can send
them to the (digital) LED.

Light-emitting Potentiometer
diode (LED) on on analog Ingredients
digital pin D9 pin A5

20



LET’S.GET.(ON).WITH.IT

1/ Open the file ts_Pot Light Dimmer.ino

2/ Look for the comment // Define pins

M Define pins.
This creates a
variable for disii-od
LED pin DT.

int potPin = AS5;
and insert the following code:
This will

3/ Look for the comment // Map the function as AR oG
PWM supports O to 255 not O to 1023 .
- ’ _ _ potentiometer
i Map the function as PWM supports O to 255 not O to 1023, .
values, which
have a range of
0-107% to PWM
Frienc\lu\ values
in the range of
0-155.

N Write the value to the LED.

and insert the following:

4/ Find the comment // Write the value to the LED
N Write the wvalue to the LED.
This will send

our value to our
selected LED pin.

! Short delay before reading again.

and insert the following code:

5/ Upload your program.
Be careful it doesw’t

6/ Try turning the potentiometer. You should see
the brightness of the LED change in response. get oo romaniel ©

The light dimmer is using s i
called Pulse Width Modglafi?: ?c::-ng
PWM) to send varying amounts of
.p’ower to the LED — which changes
|ts_brightness. PWM works by
switching the power on and off ver
fast. The longer it is on compared tg
off, the higher the amount of power
supplied (and the brighter your LED!)

On the ThinkerShield you can do

ZV\QM onhdigital pins 3, 5, 6,9, 10, 11
nd we have already h o

9,10 and 11. yevestEDon

Next Page

Gimme
more
POT stuff
straight
to the LDR




Let’s decode the Light Dimmer Code

int ledPin = G
Declares a variable called
‘ledPiv’ and assigns it the
value ‘G which corresponds
\ to the number of the pin
|‘ that our LED is connected
1 to. Wedid asimilar thing
| Forthe potPin but we
! ThinkerShield has a potentiometer connected to analog pin 5 || I0E (1 e a2 LIRE L0 A
|
]
/

ts_Pot_Light_Dimrmer

/* This is the COMPLETE program
for the ThinkerShield Pot Light Dimmer Sctivity
Written by Thinkspace vy riaas . museumfthinkspace

)
!

M Pins that support PWM are 3,5,6,9,10,11. We already have LED= reFerrins to an 0&“0&‘03 (:in.
M permanently connected to pins 9,10,11.

i Define pins.

/
int potPin = &5; ___________.__..—’ void setup( )f_§
int ledPin = 9; cmm=———"""7 ,,;—"-‘ Set we the serial forf
/! Create a variable to hold the data we read in. /, and the band rate so
int walue = 0; // we can send data to
o St e —’,’ the serial monitor.

N Turn the serial port on.

Sarial begin{115200); ,,_--) By defanlt all pins are set

-
as INPUT. S
M Initialize the LED pin as a digital cutput. /,, t the pi R
pintodeledPin, OUTPUT); ccm e e e e -7 * 'z B oy
} ledPin as OUTPUT. The
‘ potPin will defanlt to
X input as we need it to be.
o ‘~-—-> continued on opposite page




tverything between the {3 after the
void loop( ) function rans repeatedly
antil the program is stopped.

continued...

woid loop()
{

/i Read the input pin.
walue = analogRead]potPin;

M Print the contents of the warisble to the zerial monitor.
Serial.printinfvalue);

} Map the function as PWM supports 0 to 255 not O to 1023,

walue = mapivalue, 0, 1023, 0, E55); cmmc e e -
N Write the value to the LED.
analogWrite(ledPin, valug) cc e mm———e———— __\\
\
! Short delay before reading again. \\
delayw(25); )
} \‘
/
< / \
! \
/ \
/
/
l
\

-—_\ delay(25);
This lH‘erqu means do noi‘\ning
for 25 milliseconds. I+ stops ws
getting zillions of readings.

,—> value = analogReadpotPin);
This is a very common command
wsed to read the carrent value on
an omodog pin and store it in the
variable called ‘value’.

S ———
N

value = maplvalue, 0, 1023, 0, 255);
,.) The map function makes it easy to scale, or

{ map, one range of values fo another range. In
/, this case, it converts from the potentiometer’s
s values that range from a lowest value of O and

highest value of 1023 to a range from a lowest
of 0 to & highest of 255. So, if the valae from

the pot was 1023 it will be mapped to 255. If

it was say 512 (half-way between O and 1023)
it will be mapped to a value of 127 (\nalF-wo«v\

between O and 255).

\~_) omoglosk) rite(ledPin, vodo\e),'

The opposite of an analogRead, this
writes a value to the analog pin.
Becanse this pin supports PWM it
means Hhat we can send different
amounts of power to the LED.

23



Component: potentiometer

With just a little bit of extra code you can turn the potentiometer
POT.LED.Bouncer into a switch-type control and use it to bounce between two of the
. . ThinkerShield’s LEDs.
Using analog values to switch ——

LEDs on and off ,/ \

Now, test the value

Start by initialising

. to see if it is either If it is one of these values we
00 @@ °® ®0 @0 @@ ns as .. .
GND voc D6 D5 | Da D2 tW? L;ES s\‘le picked 1023 or 0. These use digitalWrite( ) to change the
ThinkerShield seen sisze outp Ds‘and o= values tell us that state of the two LEDs ... the one
ety pins the pot is turned all that’s on gets turned off and the
D | | o | ,—-) the way to the left one that’s off gets turned on.
bo = LpR : " or all the way to "
2 Reset th i ht
Dt == -\ O | | e right. |
D12 = n POTAS \ o | : : 50, when you +
D13 == | knobp “rn the
GND /VCC A0 Al A2 A3 ' : : q“ f
CHC NG ) ee 0N 00 00 v l l
]
/

Read the value
coming from
the pot on pin
A5 and store
the value in a

Wait a moment

(“‘ and loop
around again.

N
\\

variable.
Light-emitting Potentiometer
diodes (LEDs) on analog
on dlgltal pins pln A5 |ngredients
D8 and D13 —
[ ]
&

24




LET’S.GET.(ON).WITH.IT

1/ Open the file ts_Pot_ LED Bouncer.ino

2/ In the void setup section, find the comment // Initialise the
LED pins as digital outputs
N Initialize the LED pins as digital outputs.

i Turn the serial port on.

and insert these two lines of code:
Set the LED pins
as OUTPUTS

3/ Find the comment // Read the input pin
! Read the input pin.

N Print the contents of the variable to the serial monitar.

and insert the following code underneath: U503 Conlloe Arndie)

to Sei' the carrent

value from the
4/ Find the comment // Use if statement to

turn LEDs on and off

f Use if staterment to turn LED:s on and off.

pot and store it

in ‘value’.

! Short delay before reading again.

and insert these ten lines of code:\

. 5/ Upload your program.

6/ Try turning the potentiometer
from left to right and see if the
LEDs bounce back and forth.

7/ If you turn on the serial monitor
you will be able to see the values
as they change!

Test to see if the valae equals 1023.

1€ i+ does, do the first bit (ledl on,
led? off). If not, test to see if it
equals zero. IF it does, it does the
second bit. I it doesnw’t equal either
1023 or O dowt change anything.

if (value == 1023)

digitalWrite (led1lPin,
digitalWrite (led2Pin,

else if(value == 0)

digitalWrite (ledlPin,
digitalWrite (led2Pin,




Component: LDR

LDR.Basics

Read the LDR to sense light

oo oo o0 00 00 00
GND VCC Dé D5 D4 D2

. H Button B
ThmkerShgreld fwon  Buzzer

oF

Light
dependent
resistor (LDR)
on analog

pin A4

26

Learn to read the values of the ThinkerShield’s light sensor

(called a light dependent resistor) and see how it responds to
different light conditions.

Turn on the serial port

. . i 80
with Serial.beg!
we can seé the values

Send the value

-—— e -
-
-~

to the serial ~
sensor. \

from the port. \
\

|

A I

/ |

) \ 4
’/
”
/ Then have some fun

testing with different

S amounts of light on
> The LDR s an analog the sensor.

device so we use the

analogRead() function

to get a value from it.

Ingredients

—




LET’S.GET.(ON).WITH.IT

1/ Open the file ts_LDR Basics.ino

2/ Find the comment // Turn the serial porton  This will activate the
fi Turn the serial port on. serial monitor so You
can wse it to read
values.

3/ Find // Read the input pin This will put the value of
M Read the input pin. the Hs\rd- sensor into a
variable called ‘LDRvalue’.
I+ will return values between
0 and 1023.

4/ Lastly, locate the comment // Print the contents of the variable ...
N Print the contents of the variable to the serial monitar.

N Short delay before reading again.
delay(25);
and insert this line of code:

This will f:rin'l‘ the
value to the serial
monitor so you can

5/ Upload your program and then open the serial monitor by
clicking the magnifying glass icon in the top right corner.
Make sure the baud rate is set to 115200.

6/ Expose the light sensor to varying amounts of light
and discover how the values change.

AY
“~~-» Page 36

Use the POT
to control the

Sh==t Next Page

More LDR:
scare some
roaches!

QCMgMber

to ¢l
the seria| ek

Monite,

'CO
N 1o see the values
COMIhS FrOM

1°kr
COMPO“CV\tr,




Component: LDR
Read the analog values from the LDR and use changes in the values

LDR. Nig ht.Light to control the state of the ThinkerShield’s LEDs — just like an
automatic night light!

Make an automatic night light

w tests We'll need to use the

ge of Arduino map() function
so we can send the right

values to the LED pins.

First we do a fe
to find out the ran
values that
prod

always be
depending

20 00 00 @
Dé D5 I pa D2 -

~
A Y

your LDR
uces — this will
different
on the lighting

it d may
conditions an
vary a tiny bit between

ThinkerShie\dS-

Make
it stopl

H Button Buzzer
T nI_(erSPEelgld D7 i

ron.cc/t
A colaboraton batwean

D8 ==

D9 == LDR
Reset [

D11 = (1]
D12 == n PoTAS)

D13 ==

GND VCC Ao A1l A2 A3
oD 00 o0 00 00 00

————— — —— — ———

AN

N
\‘—> Then we can use
what we find out to And then we do a
el a5 62 ‘-) digitalWrite to an LED
pin to turn it on and off

and when it’s night.
as the values change.

Light-emitting
j!oFIeI(L.EDI;ign Light dependent
gital pin resistor (LDR) on Inaredients
analog pin A4 9
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LET’S.GET.(ON).WITH.IT

1/ Openthefile ts_LDR NightLight.ino

2/ Upload your program and then open .
the serial monitor by clicking on this icon

3/ Try to find the highest and lowest values that the light
sensor will produce in the place you are sitting, by exposing Change these
it to different amounts of light. e $wo nambers o

-

Look for the comment // Map the values g the low and high
! Map the walues. ! values you szf
From »\our sensor.

Look for the comment // Use conditional statement to
turn LEDs on and off
N Use conditional staterment to turn LEDs on and off. After “r\oad;ns your
program, the LED should
switch on when the Us\r\f Serial port errors?
sensor detects darkness If you ever get errors such as
if (value < 50) or low light levels! In our ‘Serial Port COM 4 already
code a low light level is in use’ or ‘Serial Port not
} anything that gives a available’, try closing all
else mapped value of <50. \ Arduino programs, unplug

digitalWrite (ledPin, HIGH) ;

the USB from your computer

digitalWrite(ledPin, LOW); and start everything again.

6/ Upload again and start scaring some roaches!




Component: push button

Push.Button.Basics

Program the push button as a
momentary switch

Learn to read the state of the ThinkerShield’s push button and use it
to switch a LED on and off — while the button is held down the LED
will come on.

Then we just keep
reading the state
of the buttonPin ==

We start by defining

vce .DG. .D.: .04. .Dz. and initialising the I/ and act when it \\
oo buttonPin as INPU I changes !
ThEror!(ersmreld Bu[t,t7on iy and an LED pin as an : ges. ||
] e=o O OUTPUT. ! !
I \4
| e N
|
|

If buttonState is
true it means it’s
being pressed
and we use a
digitalWrite( ) to
turn on the LED.

(----

Next we do a
digitalWrite() to set
the buttonPin HIGH

Initialise a boolean
variable called

Light-emitting

Button

buttonState to hold
the state of the
button. Boolean
variables are either
true or false.

diodes (LEDs) -l
on digital pins ‘o) o
D8-D13
Push button on Ingredients
digital pin D7 —
=
&

30

to make it ready for
use (by turning on a
pull-up resistor).




LET’S.GET.(ON).WITH.IT

1/ Open the file ts_PushButton Basics.ino

2/ Filnlelth.e comment // Variables Set wp a boolean
[ Verishles. (true or false)
variable for the
buttonstate

The electronics in the ThinkerShield

Lok for e oot e bt e are very sensitive to tiny changes
In current and could at times give

' Initialize button pin as INPUT.
random readings.

Sol,I itis good practice to use a
: ; Pull-up resistor that will ‘oulI°
! pinMode (buttonPin, INPUT) ; buttonPin to HIGH when?tui'sl ::ta
, digitalWrite (buttonPin, HIGH) ; Teceiving any input.
pinMode (ledPin, OUTPUT) ;
That way we can be sure that our

LED will only come on when the
button is pressed.

1
4/ In the void loop section, find // Read button value

M Read button walue.

buttonState = digitalRead (buttonPin) ; . -
This conditional
// Turn the LED on and off . . \
if (buttonState == true) statement will switch Y Page 34
the LSD on if the \‘-) Show me Next Page

digitalWrite (ledPin, HIGH) ; .
g ( ) buttonState variable :‘l'lo:vbtloz::? all::e push .
utton: make a

is frue an keep it off toggle switch
i€ iP5 not.

else

{
digitalWrite (ledPin, LOW) ;




Component: push button

Program the push button to behave as a toggle switch — press
Get.A.Toggle.On once for on, press again for off. And, if you want, you can try
ing!
Make the push button into some debouncing!
a toggle switch

we will star‘tf ,,—> If the LED was off, we flip
couple © / our two boolean variables
D6 D5 [ D4 D2 boolean variables to storé / so that it is turned on
the current state of the (sent HIGH). If it was
pbutton and of the LED. on, we will invert the
variables to turn it off.

This time
00 @0 @0 0@ bycreatlﬂga

Then, when the button
is pressed, we check
to see what state
things were in the last
time it was pressed

Button and act accordingly.
D7

Light-emitting n " \
diodes (LEDs) v
on digital pins Push button on

D8-D13 digital pin D7 Ingredients

—
|
|
-

Ao A1 A2 A3
e 00 00 00

- —— e - - - -

,/
|
v

32




LET’S.GET.(ON).WITH.IT

/’—-) When you run this, you may notice

1/ Open the file ts_PushButton GetAToggleOn.ino I/ that the button doesnw’t always

behave exo\cHn‘ as expected. Using
our button in this way is a little
like turning a hose off at the tap —

]
2/ Find the comment // Boolean (or true/false) variables :
\
‘\ sometimes there is still some eluh%cih\
\
\
\

and insert these two lines of code: .
_________________________________ . bBoolean variables

Iboolean lastButton = LOW; : HIGH/LON,
1
yboolean ledOn = false;

that will leak errous\n at the last
I true/false or even minate — just like water in a hose.
’ just 1/0. \ The problem can be solved using a

3/ In the void loop section, look for the comment \\ technigue called debouncing. Maybe
// Read button value and insert this conditional code: \

you can work out a way to do it. You

_____________________________________________________

can also ind an example in the:
1// Read button value.
! FElz\Skzi‘c\r\book\Disii'od
if (digitalRead (buttonPin) == HIGH && lastButton == LOW) menan in your Arduino software.
{
ledOn = !'ledOn; // This inverts (switches) the value.

lastButton = HIGH; // This stores the last button state.

}
else
{

|

lastButton = digitalRead (buttonPin) ;

=Y

-’
Ty

4/ Have a look a the code that starts with if (1edOn).
Can you understand what this bit of code does?
Nothing to add, just have a quick read of the code. 4

Upload and give it a try. Your button should now _
behave as a toggle switch. ==

-
-
-—— - o
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Component: buzzer

. We've learned how to make some light with the LEDs, let’s make
Buzzer.Basics some sound with the ThinkerShield’s on-board buzzer (a piezo
electric speaker).

Learn to make sounds
with the buzzer

. . That’s it.
We initialise the pin that _.____> . :

. - Simple.
our buzzer is connected '

e 0606 00 00
D6 D5 D4 D2

ThinkerShieldButton Buzzer

oF

~

to, digital pin D3, and
set it as an OUTPUT.

|

|

|

|

|
|
|
\
\

tron.cc/thinker

-—— - ——

Then we use a nice little

function called tone() Inside ; .
your ThinkerShield’
\\ ) to tell the p(rogram what) buzzer is a disk made fror:a
==/ frequency (ie what pitch special piez "

o el i
to play and how long to P ectric material,
play that tone for. When you apply an electrical

signal to piezo electric
Substances they stretch or
;':OmpreSS, according to the
requenc i .
Buzzer or piezo shabe hY Of.that signal. This
Pe changing produces sound
speaker on Ingredients of a corresponding fre
digital pin D3 and duratio quency
R n.
[ ]
b
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i1 PICK A PATH 1

|
|
|
|
~
|
|
|
|
|
l

LET’S.GET.(ON).WITH.IT

1/ Open the file ts Buzzer Basics.ino Vo coill allss see fin

the code that the
(.vinMode is set to

———,\\\
~

\
\
|
|

Jump straight
- 4 to making
music! Next Page

More buzzer:
control the
frequency

2/ Find the // Define pin comment and define the
buzzer pin by adding the following line of code:

In the void loop section, add these lines of code: ~ This will fell the buzzer

:// Play a tone with the buzzer. to ("W’\ a tone with a

| tone (buzzerPin, 659, 20); Frea\v\encv\ Cor fifc\n)

| delay (200) ; of b59 Herte for 20
milliseconds. The delay

That’s it! Upload and make some sound! of 200 milliseconds

Experiment with different frequency values. creates some silence

Mak - between the notes.
ake music!

We can now start to construct a musical phrase by
using different frequencies, note durations and delays.

Experlment with multiple lines of code like these
; tone (buzzerPin, 659, 20);

:delay (200) ; Yowu don’t ou:h«o\llw need

\ .

\ .
:delay(lOO) ; on flou»]ins antil you
, tone (buzzerPin, 400, 80); either give it another
| delay (200) ; tone command or
wse the noTonelpin)
command.




Component: buzzer

: Just like we used the potentiometer to vary the power sent to
Pitch.Changer an LED, let’s use it to change the pitch (or frequency) produced
Control the buzzer frequency by the buzzer.

with the potentiometer oot and buzzer

lise a couple
hold the

Define our P
pins and inttia
of variables t0

void loop ()
Do an analogRead of the potPin
- d st iti tValue.
- ) and store it in potValue

values from the pot

(potVa\ue) and our mapped

/ Map the potValue to our desired
frequency (freq)- P P

frequency range of 30-5000Hz.

D9 = LDR
D10 == i A 9
Reset [ @

D11 == VA
POT A5
b~ K 9 °

DA3 =

GND VvCC A0 AM I A2 A3
e o0 ee o 00 0o

-—— e - — - ——

(.--_-_-_-

void setup ()
Turn on the serial port

-——— = — - - — - - -
-

\ so we can see the Use tone() to write the
‘-) frequencies the buzzer is frequency value (freq)
producing and set buzzer to the buzzer and listen
pinMode to output. to the results.
Buzzer or piezo
speaker on
digital pin D3 Potentiometer
on analog pin A5 Ingredients
= oo | gax wo6S°
&
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LET’S.GET.(ON).WITH.IT

1/

2/

Openthe file  ts Buzzer Pitch Changer.ino

Find the comment // Create variables to hold data we read
and insert these lines:

1// Create variables to hold data we read.
|int potValue = 0;

In void loop, find the comment // Read the input pin
and add the following:

l// Read the input pin.
potValue = analogRead (potPin) ;

Find the comment // Map the potValue for PWM
and add the following code:

I// Map the potValue for PWM.

= map (potValue, 0, 1023, 30, 5000);

Then, under // Write the value to the buzzer add
the following:

1// Write the value to the buzzer.

: tone (buzzerPin, freq, 20);

The map fanction
will take the pot

' value which will be in

the range 0-1023
and convert it to a
range of 30-5000
which will give ws a
go0d scale of pitch
change.

Upload your program and try changing the pitch of the buzzer by

turning the potentiometer back and forth.

Try modifying the frequency values in your map function and the

delay value in the tone function. Listen to the results!

[}
[

Page 44
Make a

» ~~-» buzzing

light meter

Next Page

More
buzzer:
play a song




Component: buzzer

Play.A.Song

Make the buzzer
make music

o0 oo oo 060 00 00
GND VCC D6 D5 D4 D2

:L_ H Butt: ]
Think Smreld uiton  Buzzer

D8 — I le

D9 = LDR
Reset| [l @

D11 =

POT A5
prom- K3
D13 ==

GND VvCC
oo o0

Buzzer or piezo
speaker on
digital pin D3
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Create musical notes and string them together in arrays to make
music. Hear your ThinkerShield play your favourite songs!

Create a special function we
Use #define to create call buzzerPlay( ) that will read ~ ———— _
ants for each of the array values and write them

const .
tes we to the buzzer in sequence.

the musical no
will be using- A

~
\
\

v

Call the buzzerPlay()
function, then loop
around and play it again.

Set up our pins
and pinModes.

<____

Initialise a melody[ ] array

to hold the sequence

of notes for our song.

Initialise a noteDuration[ ]

array to hold the duration

of each of the notes. —_———

Start changing the
note and duration array
values to play your
favourite songs!

'

Ingredients




NOTE_CY 262

LET’S.G ET.(ON).W'TH.'T value name value

N , NOTE_DY 29Y
\ /

1/ Open ts_Buzzer Play A Song.ino #define Na‘TE G3 1‘56 NoTE_¢4 330
- NOTE_FY 349

2/ In this file we have created variables that . .
We are using a useful technique NOTS_GY 392

represent musical notes that will be played
by the buzzer. Each note looks like this: that lef’s ws give a name to
#define NOTE G3 196 a CONSTANT value at the

— start of the program. We can NOTE_BY 49y
then use the name instead of NOTS_C5 523
the valae. This is perfect for

NOTE_AY 44O

Look for the comment // Notes in the
melody. Below this line is an array (or list)
of notes. This is a list of all the notes that
go together in a particular order to form a storing musical notes.
melody. Changing the first note in the list

will change the first note of the melody.

Look for the comment // Note durations:

4=quarter note, 8=eighth note ... An array is a special type of variap|
Below this line is another array which that stores lists of values Ar,-a;'a e
. s are

contains the note durations (or lengths). Take o look af Hhe very useful in Programming. You create

Each of the note lengths in this list (or declare) an array wi
. with i
corresponds to one of the notes in our code that starks syntax: 4 the following

melody. Once again changing the first note with: ¢ )
length in the list will alter the length of the void buzzerPlay() ype name[] = {item1, itema, ol
first note in our melody.

Here’s the melody array from our code:

int melody[ ] =
NOTE_G3, NO

This is a special

function we have

incladed that our
program wses Cor
‘calls?) to flou'\ the
notes and durations

Upload the program and listen. Do you
recognise the tune?

Now, try editing each of the arrays in order
to change the music. Making changes to
the notes array will change the pitch of the
notes. Making changes to the durations

array will affect the rhythm of the melody. in the arrays.




Project 1

Electronic.Dice

Make a working six light
electronic dice

Buzzer on
pin D3

Button
D7

.

Push button
on pin D7

oo o0
[ C

of

Reset D

H Bution Buzzer
rShield 8o Buzz

ee ®0 00 00
D6 \ D5 | D4 D2

LDR
Aa

o
0/ roras

Ao / A1l A2 A3

LEDs on pins
D8-D13

Pot on
pin A5

40

Combine all six LEDs, the buzzer, the pot and the push button to
make a cool flashing and beeping variable roll electronic dice to use

with your games.

All pin variables

i For
are defined.
convenience, LEDs are

defined using an array.
We also @ declare @
‘Hoat’ variable to usé
with the randomSeed

function.

|
v

Randomise the
random number
generator, set

all pinModes are
required and start
the serial monitor.

\

4

Ingredients

Jump to the roll()
function which will scroll
the LEDs back and forth
for the selected time and
then return a random
dice number.

Go back to

the top of the loop
and wait for the
next button press.

A | A

s Eor : : return to =

a button : | main loop :
press |

! Flash the chosen LED

and make a buzz.
Leave the LED on.

A

Get the current
buttonState and
map a value from
the potPin to use

|
|
|
|
I

. Scroll the LEDs /
to determine hpw to the random /
long the roll will dice number II
scroll back and forth position. /
before stopping. - ’/




LET’S.GET.(ON).WITH.IT

1/ Open the file tsproj_Electronic Dice.ino

The electronic dice project
is totally cool but it does
(5‘1 storing the pin have some pretty advanced
2/ Find the comment // Declare ledPins array and insert the  ,alues for cach of Hhae code that you may not
following line of code: cow\f:lci’clu\ wunderstand
:fra\is\nf away. But dow’t

worry, you can still enter

LEDs in an array,
we can eou%lw Cb\dz

1
; // Declare ledPins array. f\r\rot\s\r\ M ladnr fn

'int ledPins[] = {8, 9, 10, 11, Fae progrom. it in and play aroand

c\f\a\nsins Hn%ns.c here and

Now, in void setup find the comment // Set the seed to there o try to discover

be random by reading in an unconnected pin and insert how it works!
these two lines of code:

i These two lines of code
1// Set the seed to be random by reading in start wp and randomise

| // an unconnected pin. Mo racadlenn member
 seed = analogRead(0) ;

generator in the
: randomSeed (seed) ;

MicrOfrOCUJOr.

Find the comment // Set all leds to OUTPUT by looping
through the array immediately underneath your last entry
and add the following:

i Here we use the
! // Set all leds to OUTPUT by looping through ledPins array to
1 the array.

| for (int i=0; i<6; i++)

A

' pinMode (ledPins[i], OUTPUT) ;
1

1

set the pin mode
for all the LEDs
in just & few
lines of codel!




Electronic.Dice [cont]

5/ Move down into the void loop section, locate the comment // Read in the o _
button and pot values and carefully insert these two lines: The map function is being

r d+ t t
1 // Read in the button and pot values. area o conver ¢ carren

| buttonState = digitalRead (buttonPin); NG HTRRR UG R o
! -
| scrollMaxDelay = map (analogRead (potPin), 0, 1023, 0, 500); from its range of 0-1023 t+o
0-500. This number is then
Now find the comment // Check the button state and carefully insert stored in a variable we called
this if statement and its opening { curly bracket: scrollMaxDelay.
' // Check the button state. D""‘?* do 0\"‘1“"‘":‘3
'if (buttonState == HIGH) antil the button is
pressed.

Under // Jump to the dice roll function add the
following call to the dice roll function:

// Jump to the dice roll function.
1dicevValue = roll();

Finally, scroll all the way to the bottom of the
program (past the last curly bracket). Now
carefully enter the big block of code that makes
up the dice roll function (on the next page)*

’ 9/ Upload your program and start rolling some dice!

10/ Try turning the pot to different locations
to see how it affects the roll rate.




Electronic.Dice [cont]

% Put this code all the way down at the bottom

// Dice roll function.
int roll()
{
// Clear all leds.
for (int i=0; i<6; i++)
{
digitalWrite (ledPins[i], LOW) ;
}
// Scroll the leds up and down until
// ScrollMaxDelay is reached.
while (scrollDelay < scrollMaxDelay)
{
for (int i=0; i<6; i++)
{
Serial.println(i+l);
digitalWrite (ledPins[i], HIGH) ;

delay (scrollDelay) ;
digitalWrite (ledPins[i], LOW) ;
scrollDelay += 10;

}

for (int i=4; i>0; i--)

{
Serial.println(i+l);
digitalWrite (ledPins[i], HIGH) ;
tone (buzzerPin, 100, 20);
delay (scrollDelay) ;
digitalWrite (ledPins[i], LOW) ;
scrollDelay += 10;

}

}

// Return a random integer between 0 and 6.
return random(O0,6) ;

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
:
1
: tone (buzzerPin, 100, 20);
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

Loop HAroug\A the
LeD array to turn
all the LEDs off.

The value of :crolle(Dela\q
comes from the carrent
position of the pot.

Send dice number to

the monitor.

Turn on the first LSD

in the array.

Make a buzz.

Wait for ScrollDelaw’ milliseconds.
Tarn off the same LED.

+10 to the :crolchlow\ value.

Scroll backwards f‘f\rohs\f\
LEDs 54,% and 2.

Then, when all the
fancy scrolling is done,
return a random dice
number. Back in the
Mmain program the LEDs
will slowlv\ scroll to stop
on this chosen position.

See the dice value on
the seriq| Mmonitor,

\\\

You miSH- like o make a

little paper template like this
to make it easy to see the
dice numbers. -~




Project 2

| : . Combine the light sensing capacity of the LDR, all six LEDs and
| Buzzing.Light.Meter the buzzer to make a great light level meter or scanner.

~— Make a device to scan the light

—— levels in your environment Read the LDR to get a
| light level. Then map _> Use if-th
5 +ning all se if-then
—— Buzzer on Begin by d‘eh"“[‘gR that value to a range statements to turn
. required pins: ’ that we can use for .
| pin D3 d all 6 LEDs. ' ; on the right number
buzzer and a beeping and turning of LEDs and send a

T Create 3 variables to o on LEDs. tone to the buzzer.
N Button hold the raw sensor a A |
- D7 mapped values. ) 'v
|
i : |
i | : Delay for a
| . time based on

—— B¢\ D3 I Do | b2 | Read the LDR to get a light .
i P:sh:tg;on ‘ IButton Buszer | level. Then map that value the light value.

onpi : to a range that we can use |
i \"4 for PWM on the buzzer. :
- [
| Initialise the A A v
| Ro A1 A2 A3 serial port and | |

) set all LED pins /l \ Turn off the LEDs, send
B and the buzzer ——— e | S a noTone() to the buzzer,
| D . pin as OUTPUTS. then loop around.
s on pins
T D8-D13
B Ingredients
| in A4
P 5 oo

— L

414




LET’S.GET.(ON).WITH.IT

1/ Open tsproj Buzzing Light Meter.ino

2/ Find the comment // Define pins and add the following:

\ // Define pins.

,int LDRPin = A4;

| int buzzerPin = 3;

;int led8 = 8, led9 = 9, ledl0 = 10;
;int ledll = 11, ledl2 = 12, ledl3 = 13;

Find the comment // Create variables to hold data
and add the following code:

. // Create variables to hold data.
/int LDRvalue = 0;

int value =

1 int beepRate

Then, under // Initialise the LEDs set the LED pinModes
by inserting the following six lines:

. // Initialise the LEDs.
, pinMode (1ed8, OUTPUT) ;
:pinMode(ledQ, OUTPUT) ;
:pinMode (led10, OUTPUT) ;
1 pinMode (led1l1l, OUTPUT) ;
| pinMode (led12, OUTPUT) ;
| pinMode (led13, OUTPUT) ;




Buzzing.Light.Meter [cont]

5/ Invoid loop, add the following line to read the LDR:

i // Read the LDR pin
| LDRvalue = analogRead (LDRPin) ;

Use the map function to convert the LDRvalue to a
convenient range we can use for switching the LEDs
and the beepRate of the buzzer.

Add the following line of code:

r

You will o\efw\ifelv\ want

to flou,\ around with these
first two valaes in this map
fanction (Q’-}, 230) to
tune the meter for your
lis\fxf conditions. But start
with these ones first.

-l -

Now we will add a series of if-then statements to switch on
between one and all six LEDs according to the mapped value.

Carefully add the following lines of code:

:// Light up the leds to show the level.
yif (value > 100) {

| digitalWrite(ledl3, HIGH);
1}

|if (value > 150) {
1 digitalWrite (ledl12, HIGH) ;
1}

{if (value > 200) {
: digitalWrite (ledll, HIGH) ;
1

1

1

1

1

1

}
if (value > 250) {
digitalWrite (1led10, HIGH) ;

\\-_> continued on next page *




Buzzing.Light.Meter [cont]
erial monifor

value coming

Turn on the s

-»* 1if (value > 300) { to see the \‘\9\;\%‘ Vow iF
digitalWrite (led9, HIGH); from the LDR and see e
} onds To the beep rare:

if (value > 350) { The tone frequency ot Q

digitalWrite (led8, HIGH); of 650 is a nice
Freqv\znu‘ with sooo\

volume. But feel Free {
to c\r\omg,e Hhis value ﬂ
Send a tone to the buzzer and make it beep and see what happens. - SRS
according to the mapped value from the LDR
by adding the following:

-
v

//Write the value to the buzzer. :I
: tone (buzzerPin, 650) ; ¢ ——
:beepRate = value; -———_\___,,—:-” q
1 delay (beepRate) ; Tr lowi
! Sy . Y P'aq'ng
, noTone (buzzerPin) ; nd) Lot e
beepRate = value
code to create
| different effects.
1// Wait a jiffy then turn off the LEDs. Ma be:ow\ef\nins il
| g
i delay (60) ; beepRate = value/5: GET.(ON)
D ' ) pRate = value/5; . WITH.MORE
:d:!.g:.l.talWr:!.te (ledl3, LOW); o i Gsme out o Make the beep slow
Id:!.g:.l.talWr:!.te (ledl2, LOW); how Hais will c\/\omge. when its e wW down
1digitalWrite (led1ll, LOW) ; fe b s g hen i Ii an
' digitalWrite (led10, LOW); ¢ oeepnd’ when it's light.
,digitalWrite (led9, LOW); ® Change the beep tone as the light
'digitalWrite (led8, LOW); changes instead of the beep rafe
° Chan YOU work out a way to adq
the potentiometer jnto the code
touse as g sensitivity djal?

d speed up

10/ Upload and start exposing the LDR to different light levels.
Try to find the highest and lowest light levels in your room.




Project 3

I LED.Magic.Sign

Make a cool magic sign
using all six LEDs

Take advantage of the persistence of vision effect to create a magic
sign to spell out words. Have fun making up your own characters.

Jump to See how this
printWord is done on the
,—-—) function to next page.
I’ print the word —— o _ -
®® @0 ®® @0 90 ® ] to the LEDs. N
GND vcC D6 D5 I D4 D2 ] \\
Power On s !gld Bu';t70n Bus;ef E :' ‘|
] |
a, . | :
LDR : Set pinMode for |
—— n A& | all LED pins as v
0 POT As : outputs. Initialise
o \"4 other values.

Short delay.

hold all the Os and

1s that make up the

letters in the word _-7
to be displayed. - ="

A0 A1 A2 A3
Create an array to *
[}
[}
/

., S

e mam e -

Light-emitting
diodes (LEDs)
on digital pins
D8-D13

[ Loop around forever. ) (....a’

Ingredients

18




When wowins the Shield

LET’S.GET.(ON).WITH.IT 0ack and forth, be careful

not o pull tHhe USB cable
1/ Open tsproj_ LED Magic Sign.ino ot g
on

dOn’f ‘Alf qr\wohe!)

2/ Upload the program and you will see the LEDs start to
flash rapidly. /

3/ Move the ThinkerShield back and forth in a waving motion as
shown. You should start to see the word ‘THINK’ appearing.

If you are having trouble seeing the word, try varying your
speed or movement until the word becomes clear.

Take a look at the code and find the comment // The word to
display. Locate the blocks of zeroes and ones like these:

This particular block represents the letter T. Have a look at
the arrangement of the zeroes and ones.

Can you see how the letter is represented? You might need
to twist your head to the side!

) ) This fle contains
In a new Arduino window, open the second project file: code blocks to

tsproj_ LED Magic_Sign_Alphabet.ino <—--- frco\o\ce all Hhe

Let’s try modifying our existing example by copying and letters in the
pasting one of these letter code blocks. We'll change the alphabet.
word ‘THINK’ into “THANK'.




LED.Magic.Sign [cont]

7/ Find the code block for the letter A. It will look like this:

0 _ Make sure you
1 _==""" " dowt forget this
0 last comma on
0 each of the

3 letter blocks.

8/ Copy this A block from the alphabet file to the clipboard. Then, back in the
main file, find the code block for the letter I. Let’s replace the I in THINK
with the code for the letter A.

. 9/ Upload and try it out!

10/ Now that you have changed our existing example, try creating your own
word from scratch. It’s easy. Just copy and paste the letters you need from
the alphabet file into the main file.

With a little creativity it’s easy to create your own symbols or patterns. Use
this grid (showing the letter A) as a guide and see what other shapes, letters
and symbols you can come up with.

0
1
1
1
1
0

,1,1,1,1,1,
,0,0,0,0,1,
,0,0,0,0,1

1,0,0,0,0,1,
1,0,0,0,0,1,
1,1,1,1,1,1,

’

1,1,1,1,1,1,
0,0,1,1,1,0,
0,0,1,1,0,0,

,0,1,1,0,0,
,0,1,1,0,0,
,1,1,1,1,1

1,1,1,1,1,1,

0,0,1,1,0,0,
0,0,1,1,0,0,

’

Make ap your own characters

and .s»\w\bol.s on a simple bxb
srid. Just put a €0? where

you want a space and a

(‘)

in each space you want to
be solid. Try these!l




LED.Magic.Sign [cont]

woid setupl)

! pintdodefled1Pin, OUTPUTY;
pintlode(led2Pin, QUTPUTY;
;:|inr‘-'1r_n:|el:|ed3pin, COUTPUTY;
pintiodefladdPin, QUTPUTY;
pintdodefledSPin, QUTPUTY;
pintlodelledGPin, QUTPUTY;

I
|
|
|
|
|
|
columnbelay = 25; |l
sizetord = NUM_ELEM{phrase); :
|

|

I

I

I

/

}

} Main loop which runs infinitaly.
woid loop()

} Display the word using the printword function.
printWDrd{phrase);
delayw(S);

I.---) How does the printWord

function work?

The void loop section
refeod‘eo\lu] rans the special
function in your code that
we have called printWord.
fach Hime it rans it passes
the data ‘phrase’ which is

our word.

The variable, sizeWord,is kind

3 /’7 of like the number of ‘pixels’ that

woid printWard{int wardvar[])

’/
int numPows = sizeWord ! ﬁ;
forfint j=0; 1 < numPows; j+

far(int i = 0; i=6; i+
digit:al'-.l"."r'ite(ledpinArray[i], wordyar[i+7*6])

delzyicolumnDelay);

'
}

will make wp the phrase. As each

character is six ‘pixels’ high,
numRows becomes the number of
rows of ‘pixels’ needed to make
the phrase. Then, we ased two
nested loops to u\cle Hnrous\n
each row, for each ‘pixel” and
turn on the appropriate LED.

GET.(ON).WITH.MORE

® Create your own
characters

®* Work out a way to make
two separate words
c€ome up one after the
other
® Try varying the delay
amqunts to suit different
waving speeds
® Find a way to combine
sound with your sign.




Project 4

| Learn to use your ThinkerShield’s external pin connections to
Connect.A.LED control components connected by clips and wires.

Move beyond the shield and

flash an external LED

iable
Create a varia Do a digitalWrite

220Q to hold the nur‘nbef ,—-) to send the pin Loop
7 resistor o e e are ! HIGH and turn around
+5V‘—N_\/\/\/\/‘—l 2?;:\1&@ to — we the LED on. ’
LED =

chose D5.

———————————
-

* \ 4
. Wait one
Wait one second.
resistor second.
[}
. 0
AN . ! |
‘~-) Set the pin \ |
+5 volts mode to \\
output. Temm——— ) Use digitalWrite to
turn the LED off.
External
connectors
GND, D5
Ingredients LsD 220 ohm 2 wires

resistor
” /"/ Q%’
I T




LET’S.GET,(ON}W!

Build it

1/ Attach one end of an alligator clip to the short
leg of any one of the LEDs included in your kit.
Attach the other end to one end of the resistor.

2/ Take a second wire and connect the other end of
the resistor to the GND on the ThinkerShield.

4 N\

. J

3/ Using a third wire, attach one end to the long leg
of the LED and clip the other end to the D5 on
the ThinkerShield.

Code it
4/ From the ‘File’ menu, create a new Arduino
sketch and enter all the following code: - = ==~

5/ Upload your program. If all goes well, the
LED should flash.

7/

// Flash external LED.
// Define external pin.

int ledPin = 5;

// Setup.
void setup() {

pinMode (ledPin, OUTPUT) ;

}
// Program loop.
void loop() {

digitalWrite (ledPin, HIGH) ;

delay (1000) ;

digitalWrite (ledPin, LOW) ;

delay (1000) ;

/
/

(N LED won’t flash?

M Check all of your
connections. Make
sure the clips have
good contact
with the copper
connector rings.

M Check your code.

M Try clipping to a
different external
pin. Change the
number in the code
and upload.

M Try a different LED.

GET.(ON).WITH.MORE

® Can you flash the external
LED and one or more of the
on-board LEDg?

° Usg the pot to control the
brightness of the LED.

® Use the external LED to effect
the values from the LDR and
have the buzzer buzz when
the light beam js broken.




Project 5

I Traffic.Lights

Control three external LEDs in a

Connect three LEDs to the ThinkerShield’s external connectors
and program them to change just like real traffic lights!

traffic light sequence

DigitalWrite )
toturnonthe ~=T7~ Wait a
first LED. moment
A :
' |
Repeat for : :
each LED. | v

Make your traffic lights stand
° 1. Cuta piece of cardboard
IG'ND . about 15 x7 cm.
. 2. Punch three holes for the LEDs
down the middle. Holes should
be about 5 mm in diameter.
3. Cutand fold the flaps to make
s L P 0"5 it stand.
e Rat Es mo Ll 2 ¢ LEDs 2 ¥ resistors 9 x wires cardboard
D13 = +5V +5V  +5V
ST s D5 D4 D2 ” U ” e




LET’S.GET.(ON

Build it

1/ Put all three LEDs into the holes in the cardboard
stand (you might want to hold the stand in place with
a piece of tape).

// LED traffic lights.
// Define external pins.

int red = 2;
Using three wires J-'nt yellow_— ‘?'
. int green = 5;
and alligator
clips, connect :
the short leg of ‘{mld setup )
each of the LEDs
to one end of a
resistor (that’s
three resistors,
one resistor for
each LED).

\
!
v

pinMode (red, OUTPUT) ;

pinMode (yellow, OUTPUT) ;

pinMode (green, OUTPUT) ;
}

~

void loop()

{
digitalWrite (green, HIGH) ;
delay (2000) ;
digitalWrite (green, LOW) ;
digitalWrite(yellow, HIGH) ;
delay (1000) ;
digitalWrite (yellow, LOW)
digitalWrite(red, HIGH) ;
delay (2000) ;
digitalWrite(red, LOW) ;

Use three more

wires to connect
the other end of
each resistor to GND on the ThinkerShield.

Finally, use another three wires to connect the long
leg of the red LED to D2, the yellow LED to D4 and
the green LED to D5.

S~
e e e e - — - —— .-,

Code it

5/ From the ‘File’ menu, create a new sketch
and enter the LED traffic light code.

6/ Upload your file and see how it goes!




Make a fun spoon-controlled
piano using all eight external pins

56

Use all eight external pins, the buzzer and the potentiometer
to make a fun digital spoon piano, complete with an awesome

‘wah wah’ control!

e eight constants

Defin lues Check value
1o hold our rf°te e ,> of pot for
(like we did in the. ) 'I wahWah.
Play.A.Song aCt“"g?’ |
jables.
and declare varia : 4
| ! ]
| ! I
| ! |
| ! |
| |
: Set pin modes :
| for the buzzer |
| |
| and pot. |
A 4 [
A !
Set the mode of all : \
eight digital and " \
analog external pins 7

as INPUT_PULLUP.

Ingredients

aluminiam foil

or copper '}'a\‘ag spoon q

Step through each pin
and test for a LOW.

If a pin is LOW then
send the note value
plus the value of
wahWah to the buzzer.

Loop

around
forever.

metal

9 x wires cardboard




\ \AZL
VAL A

Build it Code it

1/ Cut out eight strips of aluminium foil or copper tape 4/ From the ‘File’ menu, create a new sketch and
about 2 x 5 cm in size. These will be your piano keys. enter the following block of code to define your
Stick them to a piece of cardboard making sure there eight notes and declare our variables:
is a gap of about 2-3 mm between them. They must
not touch each other. // Digital Spoon Piano.

Using eight wires and alligator clips, connect the // Define notes. __ 0F course, you
eight keys to the ThinkerShield in the order: A0, A1, #define NOTE C4 262 can change
A2, A3, D2, D4, D5, D6. #define NOTE D4 294 Mease valeas 46
#define NOTE_E4 330
#define NOTE F4 349
#define NOTE_G4 392
#define NOTE_A4 440
#define NOTE_ B4 494
#define NOTE_C5 523

whatever you
wanfoncaﬁcu
know everwfkins
works.

// Declare variables.
int potPin = A5;

int buzzerPin = 3;
int wahWah = 0;

Now, we create our void setup () section. When
connecting to external pins like this we need to
initialise all eight pins as inputs and switch on their
pull-up resistors using a variation of the pinMode
function. Add the following code block underneath
your last entries: .

N

3/ With another wire, connect a metal spoon to the
ThinkerShield’s GND pin (you can use either one). \

S==Y code on next page




Digital.Spoon.Piano [cont]

// Set up all pin modes.

void setup () As ou can probably work out,
{

all the void looe() bit rcodlv\ does is
pinMode (A0, INPUT_PULLUP) ; cwcle aronand c\f\cckins each pin in
pinMode (Al, INPUT_ PULLUP) ; turn to see if it equals ‘LOW’. IF it

giﬂggz Ezg' igggg{gtigg; i S MhGim Mh e G Hhads mefie T

pinMode (2, INPUT PULLUP); sent to the buzzer.

pinMode (4, INPUT PULLUP) ; ) )
pinMode (5, INPUT PULLUP) ; Also, in case Yyou are wom:\armg
pinMode (6, INPUT PULLUP) ; ... we are testing for LOW and not

pinMode (buzzerPin, OUTPUT) ; BIGH becanse the INPUT_PULLUP
pinMode (potPin, INPUT) ;

wmode inverts the behaviour of the
pins. When the spoon touches a
key it completes a circuit to GND
which is LOW. 0therwise the pins
are ‘pulled’ BIGH becanse of the

// Program loop. INPUT_PULLUP.
void loop()

Finally we add the loop section of the program that will
actually play the notes:

if (digitalRead (Al) tone (buzzerPin, NOTE D4, 100);
if (digitalRead (A2) tone (buzzerPin, NOTE _E4, 100);
if (digitalRead (A3) tone (buzzerPin, NOTE F4, 100);
if (digitalRead (2) tone (buzzerPin, NOTE G4, 100);
if (digitalRead (4) tone (buzzerPin, NOTE A4, 100);
if (digitalRead(5) tone (buzzerPin, NOTE B4, 100);
if (digitalRead (6) tone (buzzerPin, NOTE C5, 100);

{
if (digitalRead (AOQ) tone (buzzerPin, NOTE C4, \\\

7/ Upload and give it a try! Touch each key with the spoon to play each note.




Digital.Spoon.Piano [cont]

8/ Let’s add a ‘wah wah’ effect!

Now that you can play standard notes with
your piano, let’s use the potentiometer to add a
‘wah wah’ effect.

Replace the program loop code you entered
previously with this modified block that includes a
command to read a value from the pot and add
that value to the frequency of each note:

// Program loop.

void loop()

{
wahWah = analogRead (potPin) ;
if (digitalRead (AQ) == LOW) tone (buzzerPin, NOTE C4 +
if (digitalRead(Al) == LOW) tone(buzzerPin, NOTE D4 +
if (digitalRead (A2) == LOW) tone (buzzerPin, NOTE E4 +
if (digitalRead (A3) == LOW) tone (buzzerPin, NOTE F4 +
if (digitalRead(2) == LOW) tone (buzzerPin, NOTE G4 +
if (digitalRead(4) == LOW) tone (buzzerPin, NOTE A4 +
if (digitalRead(5) == LOW) tone (buzzerPin, NOTE B4 +
if (digitalRead (6) tone (buzzerPin, NOTE C5 +

Upload again. This time while a note is playing,
move the potentiometer back and forth to create a
fantastic ‘wah wah’ effect. Rock.On.With.lt!

wahWah, 100);
wahWah, 100);
wahWah, 100) ; GET.(ON).WITH.MORE
wahWah, 100);
wahWah, 100);
wahWah, 100);

wahWah, 100);
wahWah, 100) ; ® Include the serial monitor so

that' You can always see the
setting of the pot.

® Use the pushbutton as a
black !(ey so that holding it
down in combination with

the spoon plays the sharp #
value for C, D, F G, A.

° :l'ry adding some code to
include the on-board LEDs jn
your piano’s effects,




Add components

There is a whole world of
components that can be
connected and controlled from

Challenge yourself

If you can think it, there’s
probably a way to code it!

The Arduino programming

Arduino Sketchbook and

Examples

Under the ‘File’ menu of the Arduino software

you will find the ‘Sketchbook’ and ‘Examples’

sub menus. You will be able to run lots of these
programs with your ThinkerShield. Just remember
to set the pin numbers at the start of the programs
to match the pin numbers of the ThinkerShield’s
on-board components.

your ThinkerShield: .
language is powerful and

e temperature and moisture flexible and for the most part,
sensors pretty easy to learn.

e tilt switches, reed switches
and relays

So challenge yourself, give
yourself a little project you
would like to try — a toy, a

e motors and steppers game or an automated piece of Sites
e LED ribbons, RGB LEDs art and just start entering some . .
code. The following websites are great sources

e digital displays of Arduino based code, projects and

components:

When you get stuck, or want
to know more, just search the
web — chances are the answer

.. . is out there and easy enough
Visit your local or online store to find!

and see what you can find.

e lights, speakers
http://playground.arduino.cc/

e home automation devices. Projects/Ideas

www.instructables.com/
id/Arduino-Projects/
www.freetronics.com.au

www.stackoverflow.com



http://playground.arduino.cc/Projects/Ideas
http://playground.arduino.cc/Projects/Ideas
www.instructables.com/id/Arduino-Projects/
www.instructables.com/id/Arduino-Projects/
http://www.freetronics.com.au
http://www.stackoverflow.com

or, the awesome,
wltimately life-affirming story of +

Thinker.Timeline

Prototype

Designed to remove
the need for a
breadboard normally
used with Arduino
microcontrollers.

Built in-house at MAAS
with the prototype
going through several
redesigns to suit
education market.

Wilariows, sometimes fragic, but
e Thinkershield!

of the board.

Thinker1 Mark |

Over 500 of the
Thinker1 boards were
made with the majority
ending up in the hands
of young learners

in MAAS holiday
programs.

Thinker1 Mark Il

The board was
redesigned to include
additional features
such as keyboard
emulation.

¢xperience showed

that the additional
Fv\ncﬂonalii’u\ made
it less wser Friendlu\.

Yay open sourcel

After seeing our Thinker1, the
Scouts made their own version

ThinkerShield

In partnership with
Freetronics, the
board was turned
into a ‘shield’ capable
of extending the
functionality of any
standard Arduino
board.
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The Thinkershield for Arduino makes it easy for anyone
to get started with programming and controlling
things with their computer in minutes! No need for
any wiring or soldering or program knowledge.

Sven if you have never seen a computer program before,

we guarantee you will be making things Hash, buze,

becf and respond in no time.

So don’t just watch what’s going on in the world of

electronics and computing. Take a step to start
anderstanding it. Grab a Thinkershield and an Arduino,
turn to the first activity in this book, and get.on. with.it!

Museum of
Applied Arts [ver1.2]
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